
Chapter 1

Humanitarian GIS: Using 
basic tools and concepts
This first chapter familiarizes you with some of the basic mapping functionality of ArcGIS 
software in preparation for the more advanced chapters that follow. After a brief introduction 
to the various humanitarian applications of GIS, you will use the ArcMap application to 
create an orientation map that shows the location of an earthquake that occurred in 
Pakistan in 2008. 

You may wish to repeat the exercises several times to ensure that you are comfortable with 
navigating within ArcMap and using its basic tools before progressing further.

OBJECTIVES
Understand cartographic and analytical applications of GIS
Manipulate map layers
Create spatial bookmarks
Use magnifier and overview windows
Measure distances
Identify features
View attribute tables
Load, unload, and create data layers
Make an orientation map
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What is GIS?
A geographic information system (GIS) is generally defined as the software, hardware, 
procedures, data, personnel, and interconnecting network that facilitate the input, storage, 
processing, analysis, and presentation of spatial data. This definition, which emphasizes the 
role of network-centric GIS, reflects how important Internet-based services have become in 
recent years. 

What is spatial data?

All information that is associated with geographic values can be considered to be spatial data. 
A satellite image of the earth is an example of spatial data stored in raster format. A line 
representing roads is an example of spatial data stored in vector format. Vector data — points, 
lines, or polygons — enables attribute information to be easily associated with geographic 
features. For example, a line representing the road can be linked to an attribute table contain-
ing fields that describe road properties such as the number of lanes, seasonal serviceability, 
and surface type. Similarly, a set of points representing villages could be linked to an attribute 
table that describes each village’s name, district, population, and postal code. Spatial data-
bases are used to manage raster and vector data, and to connect that data with nonspatial data 
(e.g., textual reports, tabular files, etc.) that is not georeferenced.

Spatial data comes in three basic forms:

Map data: Map data contains the location and shape of geographic features. Maps use three 
basic shapes to present real-world features: points, lines, and areas (called polygons). 

Attribute data: Attribute (tabular) data is the descriptive data that GIS links to map features. 
Attribute data might contain village names and district populations, and often comes pack-
aged with map data. When implementing a GIS, the most common sources of attribute data 
are your own organization’s databases combined with datasets you buy or acquire from other 
sources to fill in gaps.

Image data: Image data ranges from satellite images and aerial photographs to scanned 
topographic maps (maps that have been converted from printed to digital format).

ArcGIS Desktop software

ArcGIS Desktop is a suite of GIS products available in ArcView, ArcEditor, and ArcInfo 
license levels. The different licenses look and work similarly but vary in how much they can do. 

ArcView, the most widely used GIS license in the world, is a full-featured GIS software 
application for visualizing, managing, creating, and analyzing geographic data. ArcEditor 
adds more GIS editing tools to ArcView. ArcInfo is the most comprehensive GIS license, 
adding advanced data conversion and geoprocessing capabilities to ArcEditor. While some of 
the exercises in this book require ArcEditor (provided on the accompanying disk), most can 
be completed using ArcView. 

ArcGIS Desktop offers numerous extensions that can be added to ArcView, ArcEditor, or 
ArcInfo, three of which — Spatial Analyst, Network Analyst, and Geostatistical Analyst — are 
used in this book.
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ArcGIS Desktop consists of two application programs: ArcCatalog and ArcMap. ArcCatalog 
is a utility program that has file browsing, data importing and converting, and file mainte-
nance functions (such as create, copy, and delete) — all with special features for working with 
GIS source data. For managing GIS source data, you will use ArcCatalog instead of the 
Microsoft Windows utilities My Computer and Windows Explorer.

GIS analysts use ArcMap to compose thematic and orientation maps to carry out a wide 
range of analysis to support decision makers in the field as well as at the headquarters level. A 
map composition is saved in a map document file with a name chosen by the user including 
the .mxd file extension. For example, in this chapter you will open GISHUM_C1E1.mxd, a 
map document already created for you.

A map document stores pointers (paths) to map layers, data tables, and other data sources for 
use in a map composition but does not store a copy of any data source. Consequently, map 
layers can be stored anywhere on your computer, local area network, or even an Internet 
server, and be part of your map document. In this tutorial, you will use data sources available 
from the data DVD accompanying this book, as well as data prepared by you from datasets 
downloaded from various Web portals. You can store both types of data on your computer’s 
hard drive for use in the exercises.

GIS in humanitarian assistance
Now that we have a basic description of GIS, we can explore its role and its potential in 
humanitarian assistance. Considering GIS from a functional point of view, GIS enables 
humanitarian organizations to do the following:

•	 Visually understand and communicate what is happening 
•	 Store and share various types of information efficiently
•	 Analyze information to reveal hidden spatial relationships that can have a decisive impact 

on the outcome of humanitarian operations

Visualization and communication 

Today, the role of GIS is primarily to help decision makers visually understand the field of 
operations, in the form of orientation and thematic maps. Mapmaking (cartography) is an 
essential application of GIS in almost any humanitarian intervention. Maps may be used to 
communicate administrative boundaries, terrain, navigational routes, hazards, relief opera-
tions, and countless other types of information critical to humanitarian organizations. These 
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maps are often distributed through the UN’s Humanitarian Information Centers (HICs) and 
information-sharing portals on the Internet. Maps do not need to be static poster displays. 
The recent advent of interactive Web-based geovisualization tools, such as ArcGIS Explorer 
and Google Earth, now enables decision makers to understand the field of humanitarian 
operations dynamically. 

Storage and data exchange  

GIS also plays an important role as a storage and data-sharing mechanism. Because any type 
of humanitarian information can be associated with a location, a GIS can be most efficient 
in capturing, managing, and sharing that information. By consistently referencing all data 
with a geolocation (latitude, longitude, and sometimes elevation), a GIS can store and share 
very different types of data efficiently, as well as analyze relationships between datasets that 
might otherwise be incompatible. For example, an atlas could describe a region’s earthquake 
vulnerability and include a list of disaster risk-reduction projects there quite easily, but can it 
calculate how well those projects are addressing the region’s seismic risk? Within a GIS, such 
dynamic data comparisons can be made.

Spatial analysis 

Spatial analysis is the process of identifying meaningful patterns in spatial data and drawing 
conclusions from them. The techniques may be fairly simple, such as measuring the distance 
between a refugee camp and a reliable source of drinking water. Or they may be highly sophis-
ticated, such as modeling the impact of disaster scenarios faced by vulnerable mountain com-
munities in order to plan preventive and mitigative strategies. Some basic categories of spatial 
analysis are listed below along with examples of the types of questions that can be answered.

Queries and measurements 

•	 How many people live within 100 meters of a river’s floodplain? 
•	 What is the total straight-line distance between an airport and emergency relief drop 

zones? 
•	 What percentage of the people located above an elevation of 3,000 meters have not yet 

received winterized tents? 
•	 Are my refugee camp operations compliant with the UNHCR emergency handbook (or 

Sphere Humanitarian Charter [http://www.sphereproject.org]) guidelines for providing 
water and sanitation?

Transformations 

•	 Where is the best location for a health clinic if it needs to be within 10 kilometers of 
surrounding villages, within 50 meters of a main road, and more than 500 meters from 
areas known to contain land mines? 

•	 Which villages need to receive additional humanitarian relief, given their distance from 
roads, humanitarian hubs, and a major earthquake? 
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Optimizations 

•	 What is the shortest route between my headquarters and each of our local project offices? 
•	 What would be the best location for a maternity clinic if it needs to be within a 20-minute 

commute from surrounding villages by ambulance?

Geostatistics 

•	 What is the best village in which to rent an office based on market rates and the weighted 
distribution of surrounding populations? 

•	 Is there a relationship between a rise in cholera infection and the available sources of drinking 
water?

Hypothesis testing and simulation 

•	 What will happen if the river flood level rises 2 meters in the next week? 
•	 What percentage of local buildings will be seriously damaged or destroyed after an 

earthquake measuring 7 on the Richter scale? 
•	 What will happen if a glacier lake outburst flood occurs in this valley? 
•	 How are criminals likely to respond if we change our regimen of nightly security patrols?

Not all of these categories of spatial analysis are feasible or even necessary during most 
humanitarian interventions, but they do reflect the enormous range of ways in which GIS can 
improve decision making at the headquarters level and in the field. 

Scenario: 2008 earthquake in Pakistan
In the following series of exercises, you will produce a map for a region that has just experienced 
a major earthquake and is likely to require international humanitarian assistance. Humani-
tarian emergencies often occur in remote locations unfamiliar to responders and decision 
makers. The purpose of the map, therefore, will be to illustrate the location of the disaster 
and its proximity to population centers and transportation infrastructure. You will accomplish 
the following:

•	 Display the location of the earthquake using latitude and longitude information from an 
external source 

•	 Create and export an orientation map to a presentation for briefing officials 

A data dictionary appears in each chapter in this book. Develop the habit of studying the 
data dictionary before beginning the exercises. Likewise, whenever you receive a new dataset 
in your real work, always start by studying that dataset’s origins and contents before using it. 
Only then can you use it effectively in your application or share your outputs confidently with 
decision makers.
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Table 1.1, the data dictionary for chapter 1, lists the relevant attributes of each data layer used 
in this chapter.

Layer a or attribute Description

Major_Cities.shp Pakistan major cities (points)

CITY_NAME City name

ADMIN_NAME Administrative region name

STATUS National/provincial capital or not a capital

POP_CLASS Population range classification

Populated_Places.shp Pakistan gazetteer populated places (points)

NAME Populated place-name

Admin_Boundaries.shp Pakistan second administrative layer boundaries (polygons)

ADMIN_NAME Administrative unit name

POP_ADMIN Population

SQKM Area in square kilometers

Earthsat_150m_Pakistan.jp2 NaturalVue Landsat mosaic for Pakistan and surrounding region
aFiles containing the .shp extension are shapefiles. The last layer is a raster dataset.

Table 1.1  Data dictionary
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Exercise 1.1 

Manipulating map layers 
In this first exercise, you will learn how to open and move around an existing map document. Navigating within 
ArcMap and customizing the display of your spatial data are essential skills that don’t take long to master. Try 
not to rush through these exercises if you are new to ArcGIS: take your time, experiment with the various tools 
introduced here, and develop some deftness before proceeding to the next exercise. 

Open an existing map document

1.	 To launch ArcMap, from the Windows taskbar, click Start > All Programs > ArcGIS > ArcMap. 
(Alternatively, you can start ArcMap by double-clicking the ArcMap icon         on your computer 
desktop.)

2.	 If a welcome screen appears, select “An existing map” and press OK. If a welcome screen does 
not appear, click File > Open.

3.	 Browse to the location of the GISHUM folder (e.g., C:\ESRIPress\GISHUM), double-click the 
Chapter1 folder, and then click the GISHUM_C1E1.mxd document to select it. 

4.	 Click Open.

Note: You can also open a map document by navigating to the file using Windows Explorer and then double-
clicking the *.mxd file to launch ArcMap and load the associated layers.
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The GISHUM_C1E1.mxd file contains four layers of data for Pakistan: two point layers showing the major cities 
and other populated places, one polygon layer showing the administrative unit boundaries, and one raster layer 
containing a satellite image of the region. 

Before proceeding, let’s review the major components of the ArcMap application window:

•	 The main menu contains the familiar drop-down arrangement common to all Windows applications; it 
provides access to ArcMap’s functionality.

•	 The Standard toolbar is used for map printing, creating a new map, opening an existing map, and starting 
related ArcGIS applications.

•	 The Tools toolbar contains frequently used mapping tools to change the map extent, select features, measure 
distances, and find locations.

•	 The map display shows the map with all selected data layers visible.
•	 The Draw toolbar is used for annotating your map display with graphics and text.
•	 The Status bar shows the map coordinates of the cursor’s location in the map display.

All toolbars can be undocked and dragged by their gray, vertical “handle” to any location on your screen and 
repositioned according to your preferences. If you cannot find a toolbar, click View on the main menu, and then 
click Toolbars. 

Main Menu
Standard Toolbar

Tools Toolbar

Map Display

Table of Contents

Draw Toolbar
Status Bar
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View map layers

A digital map is composed of layers. You can see the layers listed in the table of contents on the left-hand side of 
the ArcMap window. This table of contents contains four layers. Notice the check boxes next to the layer names 
in the table of contents. When the box is checked, the layer is visible in the map. You can turn any of the layers 
on and off in the table of contents by clicking their check boxes. 

1.	 Click the minus icons to the left of the check boxes and notice how the table of contents changes 
(it works in a similar way to a data tree within Windows Explorer). Click the check box next to the 
Admin_Boundaries layer to turn the layer off; click it again to make it reappear. 

2.	 Hold down your left mouse button over Major_Cities, and then drag it below the Admin_Boundaries 
layer. 

What happened to your map? The table of contents controls the various layers of your map. Whichever layer is on 
top in the table of contents will also be the topmost layer of your map.

3.	 Return the Major_Cities layer to its position above the Populated_Places layer.

Find toolbars

ArcMap organizes individual tools into related sets called “toolbars,” which can be moved to different parts of the 
screen (floating) or docked in a specific location, in accordance with the user’s preferences. If you move your 
mouse over any icon without clicking (often called “mousing over” or “hovering”), a pop-up box will show the 
name or function of that particular tool. 

1.	 Mouse over each of the buttons in your Standard, Tools, and Draw toolbars and familiarize 
yourself with some of the core functionalities provided by these toolbars.

Locate Fixed-zoom tools

ArcMap has a suite of zoom and pan tools available on the Tools toolbar that allow you to view a map from a 
range of scales. These tools enable you to concentrate on a particular area of a map, reduce the confusion 
caused by overlapping features and labels in too small a scale, and then return to the full extent of your map to 
gain perspective.

1.	 On the Tools toolbar, locate the Fixed Zoom In and Fixed Zoom Out tools.

2.	 Click the Fixed Zoom In         tool three times. 

Depending on the speed of your computer, it may take a moment for the layers to redraw at the larger scale. With 
each click the display zooms in on the center of the map in fixed scale increments.
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3.	 Click the Fixed Zoom Out         tool three times to return the map to the previous scale.

Use custom zoom tools

1.	 On the Tools toolbar, click the Zoom In         tool. 

2.	 Click and hold the mouse button on a point above and to the left of the northwest tip of 
Baluchistan.

3.	 Drag the mouse to draw a box that extends to the southeastern corner of Sind.
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The resultant map is zoomed in on the southern portion of Pakistan. The major cities, other populated places, 
and the geology of the region are easier to discern.

The Zoom In tool can also be used to click a specific point on the map.

4.	 Using the Zoom In tool, click the Hyderabad symbol.

The resultant map is zoomed in and centered on the city of Hyderabad.
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Use the scale box

On your Standard toolbar, you will see a scale box that provides you the option of manually typing in your map 
display’s scale or selecting it from the drop-down menu.

1.	 On the Standard toolbar, click the drop-down button, and then select a scale of 1:1,000,000.

The resultant map is centered on Hyderabad at a 1:1,000,000 scale. In addition, the names for the Populated_
Places layer now appear. ArcMap provides the ability to set scale ranges that determine whether certain layers, 
and their associated labels, will be displayed.
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Zoom to layer

ArcMap allows you to zoom to the full extent of any layer listed in the table of contents. 

1.	 In the table of contents, right-click the Major_Cities layer, and then click Zoom To Layer. 

This time the map is redrawn to the smallest scale that shows all features contained in the Major_Cities layer. 
Since that scale is smaller than the visibility threshold of place-names associated with the Populated_Places 
layer, the latter’s labels are turned off to improve the map’s visibility.

Go back and forth between extents viewed

As you change your map display, ArcMap records each extent setting and allows you to go back and forth 
between the extents you have viewed.

1.	 On the Tools toolbar, click Go Back To Previous Extent         and Go To Next Extent    . 

2.	 Click these buttons to move back and forth between the map extents you have viewed. 

Use the Full Extent tool

The best way to ensure that you are looking at all of the data in your map display is to use the Full Extent tool. 

1.	 On the Tools toolbar, click the Full Extent         tool.
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The resultant map zooms out to contain every layer that is displayed. The Full Extent tool is especially handy if 
you cannot find some data that has been projected to a region outside of where you expected to see it.

Zoom using the mouse wheel

Using the mouse wheel to zoom in and out of the map display provides a quick and easy way to focus on a 
particular location.

1.	 Mouse over any location of interest in your map display and, without clicking, roll the mouse 
wheel towards you to zoom in to that part of the map.

2.	 Roll the mouse wheel away from you to zoom out from that part of the map. 

Pan

You can also move around the map without changing the scale by using the Pan tool.

1.	 On the Tools toolbar, click the Pan         tool.

2.	 Click the middle of the map display and, pressing on the mouse button, drag the map to the 
bottom edge of the display.

3. 	 Release the mouse button.
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The map display has shifted northward, though its scale remains the same. The Pan tool can be used to move in 
any direction within the current data frame without changing the scale.

Create spatial bookmarks

A spatial bookmark identifies a particular geographic location that you want to save and reference later. For 
example, you might create a spatial bookmark that identifies a study area. As you pan and zoom around your 
map, you can easily return to the study area by accessing the bookmark. You can also use spatial bookmarks to 
highlight areas on your map you want others to see.

1.	 Zoom to the full extent of the data frame.

2.	 Zoom in on the city of Karachi to a scale of 1:250,000.

3.	 On the main menu, select the Bookmarks menu.

4.	 Click Create, and then name the bookmark Karachi. Click OK.

5.	 Zoom to the full extent of the data frame.

6.	 Click the Bookmarks menu, and then select Karachi.

ArcMap zooms to the exact extent of the saved bookmark for Karachi. This bookmark is now available every time 
you use this map document, which is helpful if you frequently zoom to this extent.



Chapter 1  Humanitarian GIS: Using basic tools and concepts16

Exercise 1.2 

Using the Magnifier and Overview windows
Sometimes it is helpful to have both a larger and smaller scale display of your region of interest in order to navigate 
effectively. In this exercise you will learn how to use the Magnifier and Overview tools provided in ArcMap.

Use the Magnifier window

The Magnifier window works like a magnifying glass: as you pass the window over the data, you see a magnified 
view of the location under the window. Moving the window does not affect the current map display.

1.	 Starting from your Karachi bookmark extent, use the scale box to zoom to a scale of 1:1,000,000.

2.	 On the main menu, click Window and then Magnifier.

The Magnifier window appears at an unspecified location over the map display at the default percent magnification 
level.

3.	 Click the title bar at the top of the Magnifier window, and then drag it over the map display until 
the crosshairs are positioned over Naka Kharari.
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4.	 Release the mouse button to see the zoomed detail of the map at this location.

5.	 Click the drop-down arrow, and then increase the magnification to 600 percent.

The magnifier zooms farther into the selected position on the map display. You can also see the magnification 
dynamically as you pan the window over the map.

6.	 Click the arrow in the upper right of the Magnifier window.

7.	 Select Update While Dragging.

8.	 Drag the window around the map display to see the magnification as it updates.

9.	 Close the Magnifier window.
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Use the Layers Overview window

The Layers Overview window provides a thumbnail view of the full extent of the map (for all layers). A red box in 
the Layers Overview window represents the currently displayed area on the map. By left-clicking and holding 
with your mouse, you can move this red box to pan the map display and make the box smaller or larger to zoom 
the map display in or out.

1.	 Zoom to the full extent of the data frame.

2.	 Zoom to the city of Quetta at a scale of 1:3,000,000.

3.	 On the main menu, click Window and then Overview. 

The current extent of the map display is highlighted in the Layers Overview window with a red box.
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4.	 Position the cursor at the center of the red box, and then click and drag to move the map display 
toward India (southeast limits of the display).

The extent of the map display updates to reflect the changes made as you moved the Layers Overview window to 
a new location.

You can set options for the Overview window by right-clicking its title bar and clicking Properties. For example, 
you can choose the box’s fill symbol and the window’s background color. In addition, you can choose which 
layer is shown in the Overview window. By default, the layer at the bottom of the ArcMap table of contents is 
the one drawn in the Overview window and is used to set the extent of the Overview window. You can modify 
the reference layer’s properties from the Overview Properties dialog box; any changes you make in the Layers 
Overview window are also applied in the map and vice versa. 

5.	 Close the Layers Overview window.
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Exercise 1.3 

Measuring distance
The Measure tool allows you to measure the distance of a line or the area of a polygon. This tool is very helpful 
when estimates of ground distances are needed for humanitarian planners responsible for the logistics and 
staging of an emergency response.

Use the Measure tool

1.	 Zoom to the full extent of the data frame.

2.	 Zoom in on the region of Pakistan containing the cities of Islamabad and Lahore at a scale of 
1:3,000,000.

3.	 On the Tools toolbar, click the Measure         button.

The Measure window appears, with instructions on measuring the distance of a line, the area of polygon, or a 
feature. It defaults to the Line Measurement tool. 

4.	 Click the symbol for Islamabad, and then click the symbol for Lahore. 

The Measure window indicates that the straight-line distance is approximately 2.5 decimal degrees. (If your 
default units of measurement are not decimal degrees, you will get a different value stated in meters, miles, etc.)

5.	 Now click the symbol for Faisalabad.
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The measurements in the window show the length of the last segment and the sum of the lengths of all the 
segments in decimal degrees, or whatever default units of measurement you are using. This unit of measure is 
used because the map is set in geographic coordinates. 

Change measurement units

You can change the units to a more appropriate measure.

1.	 Double-click the Faisalabad symbol to complete the segment being measured.

2.	 Click the Choose Units         button on the Measure menu.

3.	 Select Distance and then Kilometers.

The measurements are now displayed in kilometers, which are more useful than decimal degrees for planning 
purposes.

4.	 Close the Measure box.

To measure the area of a polygon or feature, the data must be in a projected coordinate system. The four layers 
in this chapter are not projected. In chapter 3 you will learn how to apply various geographic and projected 
coordinate systems.

		  Your turn 

Use the Measure tool to determine distances between other features in the map in various units of 
measurement.



Chapter 1  Humanitarian GIS: Using basic tools and concepts22

Exercise 1.4 

Identifying features
The Identify tool displays the data attributes of any feature, or group of similar features, clicked in the map display. 

Identify a single feature

1.	 Zoom to the full extent of the data frame.

2.	 On the Tools toolbar, click the Identify         tool.

3.	 Click the symbol for Quetta. 

The Identify window populates with the attribute information associated with Quetta. Be sure that the <Top-most 
layer>, or Major_Cities, is the layer to identify from.

The layer tree shows that Quetta is the provincial capital of Baluchistan, is located at approximately 67.030940 
east longitude and 30.262511 north latitude in decimal degrees (coordinates of longitude and latitude, your 
values will be slightly different), and had a population of 250,000 to 500,000 when the attribute data was 
collected.
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Identify multiple features

You can also view the attributes of multiple features at once by including them in a bounding box drawn with the 
Identify tool.

1.	 Drag the Identify tool over the symbols for Islamabad, Rawalpindi, and Peshawar.

2.	 Click the three city names in the layer tree to flash the location and view the attributes of each city.

Control results obtained with the Identify tool

So far you have only viewed the attributes of features within a single layer. The Identify tool defaults to the 
topmost layer in your table of contents, but this setting can be modified to select another layer or multiple layers.

1.	 Select <All layers> from the “Identify from” drop-down list.

2.	 Use the Identify tool to click the symbol for Peshawar.
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The Identify window is populated with attribute data for all of the layers that intersect at the symbol for Peshawar. 

3.	 Click each of the three layers in the data tree to view attribute information.

4.	 Click the Field column heading to sort the fields in ascending or descending order. Do the same to 
sort the entries in the Value column.

5.	 Close the Identify box.

		  Your turn

Use the Identify tool to view the attributes of other single and multiple features in your map. Then 
view the attributes of one, some, or all visible layers at a certain location in the map.
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Exercise 1.5 

Viewing attribute tables
All geographic features in a GIS have attribute tables associated with them. The data in the attribute tables 
determines the geometry of the feature (point, line, or polygon), the location (i.e., point or centroid coordinates), 
and other descriptive information. Attribute tables contain a record for every feature in the layer (shown in rows) 
and for every field of information (shown in columns). 

When you clicked the cities of Quetta and Peshawar in the previous exercise, the Identify tool searched the 
attributes of the Major_Cities layer (and underlying layers) to produce the results you saw. 

Open an attribute table

1.	 In the table of contents, right-click the Admin_Boundaries layer.

2.	 Select Open Attribute Table. 

The table has seven records, one for each major administrative region in Pakistan, and 16 fields representing 
different categories of data about each region (you may need to scroll to the right of your window or increase 
its width in order to see all the columns). The FID field contains a unique identification number for each 
record, or administrative unit. The Shape field describes the feature’s geometry (point, line, or polygon). Among 
other attributes are the name, type, population, and area (in square kilometers and in square miles) for each 
administrative unit. 

Move a field in an attribute table

Sometimes you may need to reposition fields in an attribute table to make them easier to view. For example, you 
may want to directly compare the populations and areas of all provinces listed in the table.

1.	 Click the POP_ADMIN column heading in the attribute table.

2.	 Hold down the left button on the mouse, and drag this column to the right side of the ADMIN_NAME 
column. 
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3.	 Now drag the SQKM column to the right side of the POP_ADMIN column.

The population and area fields are now positioned next to the name of each administrative region. Rearranging 
the data like this has no adverse effects on the database or map. 

Sort a field in an attribute table

In analyzing attribute data, it can be helpful to sort the fields in alphabetical or numerical order. For example, you 
may want to rank Pakistan’s administrative regions on the basis of population.

1.	 Right-click the POP_ADMIN column heading, and then select Sort Ascending. 

The administrative regions are now sorted in order of increasing population. The population records for Azad 
Kashmir and Northern Areas reflect the fact that these two regions are internationally disputed and accurate 
figures are unavailable.
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		  Your turn

Sort the administrative regions of Pakistan by size in square kilometers in descending order. Then 
sort city names in the Major_Cities attribute table by alphabetical order. 

Select a feature from the attribute table

Records, just like fields, can be selected. When a record is highlighted in a table, its corresponding feature is 
highlighted in the map. A highlighted record or feature is said to be “selected.” 

1.	 Open the Populated_Places attribute table, and then sort the entries in alphabetical order by name.

2.	 Click the small gray tab at the far left edge of the second record in the table, Abbottabad. 

The selected record is now highlighted in blue. When one or more records are selected in a table, they will also 
be selected on the map, and vice versa. 

3.	 To cancel the selection, click the Options tab at the bottom of the table, and then select Clear 
Selection.
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Select a feature in the map display

You can also select objects in ArcMap directly from the map window. 

1.	 Close the attribute table.

2.	 Zoom to full extent. 

3.	 On the Tools toolbar, click the Select Features         tool.

4.	 Select the large region in the southwest of the country.

5.	 Open the Admin_Boundaries attribute table.

6.	 At the bottom of the attribute table, click the button labeled Selected. 

Baluchistan now appears as the only record in this list. 

7.	 Cancel the selection using the Options tab. Close the attribute table. 

8.	 Select several populated places in the map display by holding down the Shift key of your 
keyboard while you click each black dot. 

9.	 Open the Populated_Places attribute table, and then show only the selected records.

10.	 Cancel the selection by clicking the Clear Selected Features         button on the Tools toolbar. 
Close the attribute table. 
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Exercise 1.6 

Loading and unloading data layers
Sometimes you may need to remove and add layers to your map display using the following manual process. 

Remove data from the table of contents

1.	 Right-click the Populated_Places layer.

2.	 Select Remove.

The layer has been unloaded from ArcMap. Because we need that layer for the remainder of this chapter, let’s 
load it back into the table of contents.

Add data to the table of contents

1.	 From the File menu, select Add Data (the Add Data button is replicated on the Standard toolbar, as 
is the case for many of the tools and functions in ArcMap). 
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2.	 In the Add Data pop-up window, click the Connect To Folder button. 

3.	 In the Connect To Folder window, navigate to the location of the book’s folder (e.g., C:\ESRIPress\
GISHUM), and then click OK. 

You will have to perform this step only once. By establishing a connection, you will be directed to this folder each 
time you wish to add new data to the map. 

4.	 Open the Chapter1 folder, select the file Populated_Places.shp, and click Add.

The populated places layer (with a different, random default symbology) now appears at the top of your table of 
contents.

		  Your turn

Practice unloading and loading each of the layers in your Chapter1 folder. Note that larger data files, 
like the EarthSat imagery, take much longer to load than smaller data files, like the point feature 
layer representing Pakistan’s major cities.
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Exercise 1.7 

Creating a new data layer
In most rapid-onset emergencies, the locations of disaster-stricken areas are usually communicated as place-names  
or geographical coordinates. For earthquakes, the U.S. Geological Survey (USGS) provides real-time and historical 
data in a variety of data formats for any location around the world (http://earthquake.usgs.gov/). 

In this exercise, you will plot the location of a magnitude 6.4 earthquake that occurred near Quetta, Baluchistan, 
at 23:09:58 UTC on October 28, 2008. It, together with another earthquake the next day, killed 166 people and 
injured 370 more. Several villages were destroyed by landslides, 3,487 homes were destroyed, and 4,125 homes 
were damaged (USGS 2008).

You have just retrieved the earthquake epicenter’s latitude and longitude coordinates (30.656°N, 67.361°E) from 
the USGS Web site and will now add that information to your map display.

Go to XY location

The first step is to plot the epicenter on your map. You can use the Go To XY command on the Tools toolbar to 
navigate to a particular x,y location in your map. You can specify the location by entering coordinates in decimal 
degrees, degrees-minutes-seconds, degrees-decimal-minutes, the Military Grid Reference System, or the U.S. 
National Grid System. 

1.	 Open the map document GISHUM_C1E8.mxd. This will return you to your original map display 
settings. (Click Yes when asked if you wish to save changes to your initial map document.)

2.	 On the Tools toolbar, click the Go To XY         button.

3.	 Click the Units        button, and then view the various coordinate systems. Select Decimal 
Degrees, if it’s not the default.

4.	 To find the earthquake’s epicenter, enter the longitude (Long) 67.361 (x-coordinate) and latitude 
(Lat) 30.656 (y-coordinate).

5.	 Click the Zoom To         button on the Go To XY toolbar to locate the region of the October 2008 
earthquake.

6.	 Click the Flash         button to identify the precise location once again.
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7.	 Click the Add Point         button to mark the earthquake’s epicenter. If your map label for 
Baluchistan covers the epicenter symbol, zoom or pan your map display as required to reveal 
the symbol.

A point marker is added to the map display. Because the default marker blends into the rest of the map display, 
you will change its properties. 

Change point marker symbol properties

1.	 Using the Select Elements         tool on the Tools toolbar, click the earthquake point marker, and 
then delete it using the Delete key on your keyboard. We will re-create it using more effective 
symbology.

2.	 On the Draw toolbar, click the Drawing menu and then Default Symbol Properties.
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3.	 Click the Marker Properties button to open the Symbol Selector.

4.	 Scroll down and click the Circle 22 symbol.

5.	 Select the color Solar Yellow and size 25.

6.	 Click OK to close the Symbol Selector, and then click OK to close the Default Symbol Properties.

7.	 On the Go To XY toolbar, click the Add Point button again.

The epicenter is now more obvious. You will now convert it from a graphic into a feature layer.
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Convert graphics to features

1.	 Close the Go To XY toolbar.

2.	 On the Draw toolbar, click the Drawing menu, and then select Convert Graphics To Features.

3.	 In the Convert Graphics To Features dialog box, ensure that your conversion preferences are as 
follows:

•	 Convert: Point graphics
•	 Use the same coordinate system as: the data frame
•	 Output shape file or feature class: Earthquake.shp (to go into your Chapter1 folder)
•	 Automatically delete graphics after conversion: Yes (checked)

4.	 When your dialog box matches the image below, click OK.

5.	 Click OK when asked if you want to add the export data to the map as a layer.
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6.	 Zoom to the full extent of the map display.

The map display now shows the earthquake’s location within Pakistan, and the marker now appears as a point 
feature (vector) layer in your table of contents. The earthquake’s location has been saved as a separate shapefile 
in your data folder.

Hyperlink photos or URLs to maps

ArcMap enables you to hyperlink images or Internet addresses to the map so that they are displayed when a user 
clicks an associated feature. This tool can be very useful during and after humanitarian operations for verifying 
the status of particular locations affected by an emergency.

1.	 Zoom in toward the earthquake marker until you can see the village of Ziarat.

2.	 Using the Identify tool, click the symbol representing Ziarat.

3.	 Right-click Ziarat in the left window pane of the Identify window, and then select Add Hyperlink.
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4.	 Select Link to a URL, and then enter the following hyperlink:
http://www.irinnews.org/Report.aspx?ReportId=81622

5.	 Click OK, then close the Identify window.

6.	 On the Tools toolbar, click the Hyperlink         tool.
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7.	 Click the symbol representing Ziarat.

Your Internet browser will launch and navigate to the hyperlinked Web site. The hyperlink function is not limited 
to Web sites. Documents that are stored on your own computer, such as word-processing files, presentations, 
spreadsheets, and photographs, can also be linked to map features, making them more accessible in the future.
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Exercise 1.8 

Making an orientation map
You now have a simple orientation map showing the location of the October 2008 earthquake near Quetta, 
Pakistan. Your final step is to prepare the map for export or printing. 

Change data view to layout view

The map window that you have been working in until now is called Data View. You will now switch to a different 
map window, called Layout View, to prepare the map aesthetics. 

1.	 Zoom to full extent.

2.	 Click the Layout View        tab in the bottom left-hand corner of the main map window. 

3.	 Now click the Data View         tab (to the left of the Layout View tab). Observe the difference.

4.	 Return to the Layout View window. 

The Refresh View    tab (to the right of the Layout View tab) can be used to ensure that your map is up to date 
with respect to any recent changes made to it.

Apply a map template 

The fastest method to generate a professional-looking map is to use one of the map templates included with 
ArcGIS or a custom template developed for your organization. Such templates typically contain a predefined page 
layout that arranges map elements such as north arrows, scale bars, and logos. All you need to do is prepare 
your map display and apply the template, and you are ready to export or print the map. 

1.	 To apply a new template to an existing layout, click the Change Layout         button on the Layout 
toolbar.
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2.	 Explore the various templates, and then choose the Asia.mxt template from the World category. 

3.	 Click Finish.

4.	 If the top of your legend is hidden, right-click the portion under the map, and then select Order > 
Bring to Front.

The template has been applied to your map and is ready for customization.

5.	 On the Standard toolbar, set the map scale to 1:10,000,000 (this will ensure that your map fills 
the available space in the layout).

6.	 Double-click the “Asia” title box and rename the map Pakistan.

7.	 Double-click the Legend box, and then click the Items tab.
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8.	 Click the Earthsat_150m_Pakistan.jp2 layer under Legend Items, and then click the Remove 
button.

9.	 Click the Legend tab, and then clear the Show option. 

10.	 Click OK to accept your new legend properties.

11.	 Left-click the data frame to select it.

12.	 Right-click the data frame, and then click Properties.

13.	 Click the Grids tab, and then click Properties.

Remove 
Button
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14.	On the Intervals tab, change the X and Y axis intervals from 10 degrees to 5 degrees.

15.	 Click OK.

16.	 In the Data Frame Properties dialog box, select the Data Frame tab, and then change the radio 
button to Fixed Scale.

17.	 Click OK to close the Data Frame Properties dialog box.

18.	 Double-click the scale bar. 

19.	 On the Scale and Units tab, change Division Units to Kilometers. Click OK.

Your map is now ready to be exported for printing. As an alternative to applying a map template (as you did 
above), you can add elements and customize your map manually by clicking Insert on the main menu.

Export your map

It is often useful to export a finished map to a file format that preserves its appearance and makes it accessible 
to anyone regardless of his or her GIS skill level. When exporting from ArcMap to PDF, be sure to embed all fonts 
in the document. 

1.	 On the main menu, click File, and then select Export Map.

2.	 Export your map to your Chapter1 data folder as PakistanEQ1.pdf. 
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		  Your turn

Practice changing and customizing your map layout settings. At a scale of 1:1,000,000, the region 
surrounding the epicenter appears much larger, and several changes become necessary: the grid 
spacing needs to be smaller, the map title needs to change, the Admin_Boundaries layer in the 
Legend box becomes redundant, and so forth. Regenerate your map to be effective at this finer scale 
and save it as PakistanEQ2.pdf.

You have completed your first exercise in ArcMap and successfully exported your map product.

What to turn in
If you are working in a classroom setting with an instructor, submit electronic copies or printouts 
of your map at scales of 1:10,000,000 and 1:1,000,000.

Assignment 

Write a short essay (5–7 pages) that describes how an organization that provides humanitarian 
assistance uses GIS. Consider humanitarian agencies within the United Nations, a national 
emergency management agency, or a nongovernmental organization. 

In your research, identify how your chosen organization applies GIS to support its mission, and 
explain the process it uses to generate GIS products and services. Also describe the size and 
expertise of its GIS program staff, its primary types and sources of GIS data, and how it delivers its 
products and services to end users. Finally, consider the organization’s use of the Internet for finding 
GIS data, publishing finished products, or facilitating Web-based GIS.

What to turn in
If you are working in a classroom setting with an instructor, submit an electronic copy or printout 
of your essay.
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